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About Flip Book Maker for Shopping

Flip Book Maker for Shopping is an amazing
page-turn converter which can publish virtual
shopping catalog with 3D page turning effect. With
this powerful program, you can edit the flipping
pages with multimedia and other functions, which
can help you to turn the PDF catalogs into
interactive sales tools. You can Insert dynamic
price for the goods; add page link, web link, e-mail
link to the electronic flip catalogue; add buttons to
call JavaScript function, open flash window or

photo slideshow.

Note: This product is distributed on a "Try before-you-buy"
basis. All features described in this documentation are
enabled. The registered version doesn't insert a watermark in

your generated page-flipping eBooks.
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Software Features

Dramatic application of editable shopping cart

1.
2.
3.

8.
9.

Add text button to define its application (buy now, download, etc.);

Embed dynamic price box for the goods;

Insert pop up photos or image(album) to design photo slideshow;

Add buttons from resources;

Add links to open a link, call JavaScript function, open flash window and
photo slideshow, etc;

Embed flipping pages with video, audio, flash, YouTube video;

Add button to call new actions(go to the appointed page, open a link, play
audio, etc);

Set printable area for your readers to print out coupons directly;

Copy and paste selected objects (link, video, flash, image, etc.);

10. Delete the unwanted objects;

11. Zoom in and zoom out while editing the pages.

Optional output formats:

HTML makes it possible to be viewed online or just offline;

Zip and Exe make it easily to be stored and sent via emails;

App format enables you to view the flip book separately on Mac;

Mobile versions can run on your iPad, iPhone, Android mobile phones...;
Burning to CD allows it to play on computer with defined title and

automatically play mode.
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Setting control tools:

1. Convert or batch convert the PDF files to interactive virtual flipping catalog;

2. Define the language for your electronic flash catalog or use two or more
kinds to make languages switchable;

3. Choose a template(theme) from the 3 templates(classic, float and spread);

4. Customize your own template;

5. Show or hide the toolbar or other buttons (home, full screen, help, share,
social share...);

6. Set password to retain access authorization;

7. Set permission for printing, downloading, (social) sharing;

8. Self or blank open window for home page and links;

9. Add background music and set looping time;

10. Font setting for flash, bookmark, buttons...;

11. Page shadow setting, left-to-right or right-to-left reading;

12.Zoom in & zoom out button makes it easier to view the stylish digital
shopping catalog;

13. Choose the Minime style that hides the toolbar;

14. Color setting for background, font, buttons, icons;

15. Edit book proportion and margin;

16. Insert page number and start page number;

17. Auto play setting allows it to play as soon as you open the flash flip catalog;

18. Add Google Analytics Integration to track the statistics;

19. Help button enables you to insert a file to show in the interactive digital
catalog;

20. Add about button to show your company file and contact information.
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Virtual shopping catalog features:

1.

2.

10.
11.
12.
13.
14.
15.
16.

17.

Open shopping catalog in hard cover, or view from right to left;

Turn a page by clicking the page shadow;

Turn a page by dragging the corners;

Turn a page by sliding the mouse wheel;

Turn a page by clicking the "First/Last, Previous/Next Page" buttons;

Turn to a certain page by entering the page number;

Click button to play/stop the video, flash, audio, etc;

Click button to open a link or call JavaScript function;

Open a photo slideshow with setting mouse action;

View the eye-catching price box in dynamic mode;

View the flip shopping catalog automatically with auto play;

Read the flip shopping catalog in full screen;

Zoom in and zoom out to get a better view;

Download and print out the electronic flip catalog;

Print out the appointed printable area as a coupon;

Share the interactive virtual flipping catalog with others via e-mail, Facebook,
Twitter...;

Read the interactive digital catalog with portable devices like iPad, iPhone,

Android phones.
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Operations:

» Easy Import:

|
1. Launch the program via the desktop shortcut '

’

A2y Import Shopping Catalog{PDF .
% Import Shopping Catalogl }toenterlntolmport PDF

2. Click the "Import PDF" icon
interface;
= Import EDF EI

Source PDF Flie

| | ’ Browse.. l[ Qpen it ]

The Page Ranges to Impork Watermark

® &l pages " Place a custom kext or image

L
(@ Gl R I:I ‘ - Watermark{Stamp) to the file(s)
>
Quickly import (Only import 10 pages to initial preview) Sek Watermark

Page Guality

Quality And Size: |High quality large file size w |

M4 High values produce better page quality but require more disk space and more time to download.

Import bookmark Import links [JEnable search Detect wide pages

Cancel

3. Click [E icon to choose PDF file from your computer;

4. Click [ L= licon to open and see if it is the file you want to convert;

5. Choose to import all pages or custom range pages;

. Set Watermark |, . . .
6. Click I&Lcon to enter into watermark selection interface, choose

watermark(s) for the flipbook;
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= Selete Tatermark

select one or more Watermark(s) Watermark Preview

+ - E‘ X | 4 @; @ [ Wiew Stvle ~ [#] Check al

I OK ] [ Caneel ]

there are 5 types of watermarks for you to choose: Text Watermar, Dynamic
Datetime watermar, Image Watermar, PDF Watermark and Shape Watermark. You

can define the parameter for different watermark.

Text Watermar:

= Add Text Watermar
A= Add Text Watermar

Texk Name

Name: = |
Test: |a-pdf watermark

General | TestEffect | Range | Links | DateTime |

Text Propertiss

Eork: |F beletia ] O [IEmbeded Font
size: [24 |- color: [ R

Style: []Bold Ciealic [ underline

Pasitian in margins Margins
mwaw [Fluse %ie) .
|m | m| m|

m = m

a-pdf watermark

[IFit to margins

il Style(z)

Metric units
Units | Inches |

Dynamic Datetime watermar:
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Eermat [print ot {onm-de-yv} ~|
Text:

FantiH): | Courier |

Text color: [

Fonk Sze: |24

Pasition in margins Marging

= [¥]Use #e(p: _
ww w e B senr o

print at:05-06-12

lefifo |4

0
Battom: |0 =

¥ [0.00 |

Unit.

| nches

Image Watermar:

% Add Tmage Watermar

A: add Image Watermark

®

Image Hame

Hame: | T8

Image; | | [ Browse:.,

General |Effect | Range | Links |

Image Properties

width: [0.00 B Height: [0.00 g

Fosition in margins | Mergins
2 [Juse %%
M m m Top

Left: E__l o

Right:|0 |*

= = &

Bottom: }p E

[CIEit to margins [ strecth ta margins

Unit

| Inches

v

PDF Watermark:

= Add PDF Natermar
& PDF Watermark
Watermark Name

4 40 Ji
Hame: | PDF Wakermar

\
POF: | | [Brawse... |

General |Effect | Range |

Page Range
@allpage  Opsges |
Properties

Position inmargins— Margins
= = — [“luse =
m m = Topi [0 =
L L Lefti o 2
m = m

[“IEit to margins

Unit

[tnches

-

Shape Watermark:
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FE e
[]Eit to margins ;; [ atrecth to margins jj

Inches v

7. Choose the output quality and size

Pages Quality and Size

Quality And Size:

High quality large file size
Medium guality medium file size
Low quality small file size
Lower quality smaller file size

High values [

i .
= butrequire m

8. Enable or disable the following functions:

AT Import bookmarks to the flipbook so that your readers can find

the contents easily;

I o ik If there are links in your PDF files, the flipbook will retain the

links;

VlEnablesearch  cpock this option to enable search functionality in created

flipbook.

[Vipetectwide pages  This ontion can enable the PDF file to be presented in

two-page spread in output flipbook.

. Import Now |, . .
9. Click Elcon to enter into custom setting interface.
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> Edit Shopping Cart:
Flip Book Maker for Shopping is special design for online shopping catalog, and
this powerful software enables you to edit the flipping shopping catalog with

multimedia and other functions.

SI o Edit Shopping Cart

(1) Click : icon to enter shopping cart editing interface;

{5 dit Page for Shopping Cart

Flip Book Maker for Shopping

Builder digital shopping catalog with page flipping effect.

m

(2) Click icon to add text button, draw a link box * -+

want, and then you will see the text button properties:

Copyright 2010 by FlipBookMaker.com
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Text Button Properties
Button Caption:

Font Colar:

RL:

Advance Action Options

action Info:ftarget: blank)

L2

H:

You can define colors and alpha for mouse actions(over, down, normal actions),

adjust the size and add hint address.

. Advance Action Options| | . .
Click icon to call new action: Go to page, open a link, call

Javascript function, open flash window, play audio and photo slideshow.

Action Options

O Dowrr @ Ll 8 Moye

® Cver ® Cut

M Gofopage: O Openalink @ Call Javascript function
& Open Flash Window @ Play sudic. ® Phato Slidesh

LIRL:

T

Copyright 2010 by FlipBookMaker.com
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@ Go to Page

Select"Go to page" and define which page to go, for example page 4

50 To Page:

, click"OK", then you can go to page 4 directly by

clicking the page link.

®0Open a link

define link target as blank, self, parent or top and you will go to where you want.

Link Target:

Blank
SELF

Parent

Top

B Call Javascript action

Write down javascript function text in the box and

make sure the Javascript wrote into the index.html page, then you can call the
javascript function by clicking the action link.
@O0pen a flash window

Select "Open a flash window", then the"Open Window Action Properties" box will

pop up.

Copyright 2010 by FlipBookMaker.com
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Open Window Action Properties

wWindow Type: Open the window to play a video
i} ‘,l'l.ll'ir' j Dy |: ar t =l t 0
S b colect The File

Fl choose the resource file

doy Caption:

Wi |j oy Hei I;.l h t:

Window Type: Open the window to play a video

Open the window to play a video

Window Cantel Open the window to show a SWRiFlash)

Open the window to shiow sorme text

Select the window type and then select the file from your computer to imput text
content directly, define window caption, width and height.
®Play Audio

Select an audio file and choose auto play or not;

I Select a Audio FiIe(MF‘BJ: m

®Photo Slideshow

Select"Photo Slideshow", then it will pop up the below interface:

Copyright 2010 by FlipBookMaker.com
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Photoes Information

LRL Action

Add Images

Add images from your computer, and press"OK". And when you clickthe link, the

photo slideshow will pop up.

(3) Click icon to add dynamic price to the pages

———— e

Ty

PR

- 1
'a :

e

Define hint, price unit, price, background color, URL and other parameter for the

dynamic price box as below box.

Copyright 2010 by FlipBookMaker.com
-13-



E,.. @ Convert PDF to Digital Shopping Catalog Utility
User Document

Properties

Hint

Price Linit

Price

Background Color

URL:

Advance Action Options

Action Info; (target: _blank)

(4) Add pop up photos to the pages

0
Click icon to add pop up photos. See as below box:
Phatos

LRL Action

Add Images
Advance Action Options

Artion Info:

Add images and define the action settings, then when you are viewing the
flipping shopping catalog, the photos will pop up.

(5) Add button from resources

Click icon to enter into button resources box, choose buttons from the

resources. Or you can import resources from your computer.

Copyright 2010 by FlipBookMaker.com
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Import Resources

(6) Click icon to add links, draw a link box “----- " on the the area you want,
and then you will see the link properties:

Link Properties

Action Options

ko action.

Mormal Colar: Mormal Alpha:

(7) Add movie that plays FLV

Clik to add movie that plays FLV, and you will see the movie

box.and movie properties interface as below:

Copyright 2010 by FlipBookMaker.com
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Movie Properties

Select FLY Mavie

Mliowie: Blark:

Whien click Play button

il
Stop Movie: When leave the page
H

Select FLV movie and player skin color, define play and stop action, define
interface size.
(8) Add Image

CIick to add an image, you can choose an image from your computer and

define action options as above mentioned: go to page, open a link, call javascript
function, open flash window, play audio and photo slideshow.
(9) Add Sound

Click ' to add music to the flipbook. You will see the music palyer i‘l_‘"‘t ,
select sound from your computer and define mouse actions. When you open the

flipbook, just click j:J_"“t and the music will start to play.

(10) Add SWF

Click .to add SWF to the flipping page. Just select a SWF from and then
define proportion for the SWF.

perties

Select a Swf

SWE: Blank

(11) Add Button

¥
Click . icon to add buttons to call new actions. Select an icon(SWF or image)

Copyright 2010 by FlipBookMaker.com
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for the new action and select the action: go to page, open a link, call javascript
function, open flash window, play audio and photo slideshow.

Button Properties

Select an Icon(SwF,Image)

Button: Blank

Action Options

(12) Add Youtube Video

m
Click icon to add Youtube video. Input Video ID and parameters, define

mouse actions and proportions, and you can see the Youtube video in the
flipbook.

YouTube Yideo Properties

Wideo ID:

Wideo Pararneters:

Plary Morvie: wihen click Play button

Stop Movie: when leave the page

(13) Add Printable Area

=
Click icon to add printable area as coupon.

Copyright 2010 by FlipBookMaker.com
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Colar: . Cwver Alpha: B

Border Colar: Border width: B

Title:

Description:

If you want coupons in your flipbook, you can add printable area, just define color,
title, description and proportions for the coupon. And you readers can print it out
with ease.

After finishing editing the flip pages, just click "File->Save And Exit", then all these
amazing functions will present in your filpbook.

> Custom Settings:

e [ @

Plese customize the fiash template here

' .
ETool B Settngs A 0 7

3 ~ FlipBook Maker for Shopping
The Book Loga T
Logo IR
Book Tit winw.fiphl.. | = — —_— —
Poge Number Box On ., False

ELLLEE Builder digital shopping catalog with page flipping effect.

Btome Buttor

T

| =c—s Ny N —

; =1 ' [V

Copyright 2010 by FlipBookMaker.com
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Flip Book Maker for Shopping enables you to make your flipbook in your favorite
style. The custom settings mainly include 4 parts: Template Selection, Tool Bar
Settings, Flash Display Settings, Flash Control Settings.

1. Template settings:

(1) CIickHicon to enter into template selection interface, choose your

favorite template and theme;

E Seleet a Template CE®E

. hoose a flipbook template here. (Double-click ko make a quick selection)
[ ] {More and mare kemplates will be provided in future. )
J et More Themes Crline
Classical Template enables wou ta show vour page-flipping eBook in unadarned style, which wou can even use ta show your eBook.
withaut the bottom toalbar, so that all of the attention will be Focused on wour eBook content. OF course, wou can insert a proper
background image to deep the impression of vour audience koo,
| Templates s
|
| lassical -
Float s
Spread e
Colorful
Dazele Florid Flow-red
v
‘ Refresh J [ Remove The Template } [ Remave The Theme ] Remove functions needs Addministrator rights!

There are 3 templates for you to choose: Classical, float and spread.

Classical:

Blank H Blues H Colorful

Dazzle Florid Flow-red

Float:

Copyright 2010 by FlipBookMaker.com
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Blank Blues Colorful

Dazzle Florid Flow-red

Dazzle Florid Flow-red

(2) Click Q icon to save the template setting for later use;

(3) CIick‘g icon to import flash template setting;

2. Tool Bar Settings:

Bl Tool Bar Settings
HTitle Bar
EButtons Bar

Tool Bar on top Falzse
[EButton Icons

(1) Title Bar

Copyright 2010 by FlipBookMaker.com
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ETitle Bar
The Book Logo C:\Wsers\Public\Pict. ..
Lego LIRL
Book Title www.,FlipBuilder .com
|| Page Number Box ... |False ﬂl

@ Choose a logo (Image or SWF only) for your flipbook;
@ Define the logo URL;

B Define a title for the flipbook (This value accept HTML format text. For example:

<a href="http://www.FlipBookMaker.com'
target='_blank'>FLIPBOOKMAKER.COM</a> | <font color="#ff0000' size='14'>Red

Color</font>);

@ Decide to make page number box on bottom or nor.

(2) Button Bar

| ElEuttons Bar
EHHome Button
Habout Button
HFull Screen

Help Butkon Show

EHPrint Config
HDownload setking
HZound
EHZoom Config
[H3earch
[Hshare
EHauto Flip
EHEookmark
EHsingle Page
EHLanguage

@Home Button

| BlHome Button
Home Button Visible Hide
Page URL
Cpen Window Self

Show/hide home button and set home page URL; decide to open window in self or

blank window.

®About Button

Copyright 2010 by FlipBookMaker.com
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| Blabout Button
&baouk Butkon Yisible  |Hide
Conkenk

Show/hide about button and define content such as company file and contact info.
® Full Screen Button

| Full Screen Button Show "

Show/hide full screen button; click icon to view the flipbook in Full Screen,

click icon m or "Esc" button to exit from the Full Screen.

@ Help Config

| ElHelp Config
Help Button Show
Help Content File
Help Window Width 400
Help Window Height 450
Show Help At First Hide

Show/hide help button; choose the help content file (image and SWF only); define
help window width and height; choose to show/hide help at first.
The help content file will show you manual of this software, if you leave it empty,

default help content will show up.

® Print Config

— i ——

| ElPrint Config ‘

Print Enable Yes
Print Watermark File

Enable/disable printing function; define watermark file (image and SWF only) to

be printed out. Click icon to print out the flipbook.

® Download Config

| ElDownload setting
Download Enable Mo
Download URL

Copyright 2010 by FlipBookMaker.com
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Enable/disable to download the flipbook; define the download URL. Click

icon to download the flipbook.

@ Sound Settings

| BlSound
Enable Sound Enable
Sound File
Sound Loops -1

Enable/disable background sound; select background sound from your
computer; set sound loops (set"-1" to play the sound all the time while viewing

the flipbook).

4” . n n n n n
.lcon stands for "sound on"; stands for "sound off".

Zoom Config

| ElZoom Config
Zoom in enable Yes
Scroll with mouse Mo

Enable/disable zoom function: Clickmicon to zoom in; cIickm icon to zoom

— G .
out. In the float template, you can also use to adjust

the page size.

Choose to scroll with mouse or not.

@ Search Function

ESearch
Search Button Show
Search Highlight Color | Il 0x408080
Least search charac...|3

Choose to show search button, then you will see the search buttonm in the
tool bar (make sure you have checked "Enable Search" option in "Import PDF"
interface); define highlight color and the least search characters; click the search

button and you will see the popup search window, type the search words and

cIickE, then you will find the wanted content.

Copyright 2010 by FlipBookMaker.com
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@ Share

Elshare
| Share Button
Sodal Share Button | Show

@ Share Button:

| BlShare Button |
Share Button Show
Email Subject
Email Body fink}

Choose to show the share button, then the e-mail share button Ewill

show up in the tool bar, your readers can share your flipbook with others via
e-mail if they enter the e-mail link with subject.

€ Social Share:

Social share is very useful to make your flipbook shared. Choose to show social

share, the social share button mwill show up. Your readers can share your

flipbook with their families and friends via Facebook, Twitter, Digg, Yahoo and

other social networks.
Social Share

] Facebook 3 Twitter

in' Linkedin Google

B Delicio.us Yzhoo

B, Diag ET stumbleUpon

Bl % I
Lrg e A4 gk

Eij Reddit m Moot

2 Technomt + More

T3Auto Play
|  Eauto Flip |
Enable fes
Flip Interval 3
Flay Count 1
Auto flip when startup |No

Copyright 2010 by FlipBookMaker.com
-24 -



Convert PDF to Digital Shopping Catalog Utility
User Document

Select "Yes" to enable auto flip mode, click u icon to start auto flip. Define
the flip interval (seconds of staying on each page); then set play count to
define how many times of auto play for the flipbook (-1 stands for continuous

play). Choose "Yes" or "No" to automate auto flip when start up.

3Thumbnail Button

|| Thurnbnail Button !Enable ;I

Enable thumbnail button, click the thumbnail buttonﬁto view the page

thumbnail of the flipbook. See below the thumbnail interface:

Food Coraliant

t3Single Page
ElSingle Page
Enable Single Page Enable
| Show Defaultly False |

Copyright 2010 by FlipBookMaker.com
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w0

Enable/disable single page to see the flipbook in sigle page or two spread

pages. Click D icon to view the flipbook in single page; click micon to get

back to the normal two spread pages mode.

t3Language Settings

| ELanguage
| Language English;Chi.ﬂ
Switchable Mo

CIick'ﬂicon to enter the language selection interface:

fonpizgs ==
You can new or edit a language for the flash fipping book, The Labled column below i the string that will be displayed in the
flash. The lanquage wil be list in the flash tempiate settings.
Al the checked language on the left, wil be pushed to flash book when publish. The first checked language on the top will be
the default language in fiip book. You can point a language to the published fipping-book by specify in the address lie
v hittp: . XX, com/mybaok. htmiZpageindex=+48lang=Japanese
Lauangues
] Engish I B saveas... | | (33 Load... | | [ Eait |
I ichiness Language Settings
[¥] French
S Label Labeled
] Arabic
First Button Premiére page |
"] German 1.8
5 Next Page Sutton Page suivante |=
Ll Greek Last Button Derrigre page
[ Hebrew Previous Page Button Page précédente 1
[ rtalian Downioad Button Télécharger
=) - Print Button Imprimer
= L Search Button Recherche
B Portigues Clear Search Button Clear
[T portuguese Book Mark Button Marque page
Help Button aide
Enable FullScreen Button Plein écran
Disable FullScreen Button Fenétre
Sound On Button son
Sound Off Button Muet d
i X 4 &
ok dose |

Define the language for the flipbook, or you can choose two or more
languages and choose "Yes" for language switchable option, then you and

your readers can select the preferred language while reading the flipbook by

clicking the |Jicon.

Click . to create a new language; click R to remove the selected
. | Edit _ _
language; click who edit language item.

t5Tool Bar on top

|| Tool Bar on top False |

In the float template, you can choose "True" for "Tool Bar on top", the tool

bar will show up on the top of the flipbook.

Copyright 2010 by FlipBookMaker.com
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16 Button Icons

| ElButton Icons

|| Icon Color

Click -ﬂicon to enter the color selection interface, choose color for the icons.

3. Flash Display Settings

|E| Flash Display Settings
Background Alpha 1
Retain the book to center  |Yes
EHFont
Initial Show Mone
Show Corner Flip Effect | False
HBackground Config
Flash Window Color B 0454545
Page Background Color CJoxfFret
HBook Proportions
HBook Margins
HPage Shadow
Hide Book Frame Bar Mo
Right To Left Mo
Hard Cover Mo
Flipping Time 0.6
EHPage Mumber
EMinime Style
(1) Background Alpha
| Badkground Alpha ]

Set the value of alpha (0 to 1) to control the transparence of the background

in flip book.

(2) Retain the book to center

| Retain the book to center

Yes

=

Set "Yes" to retain the flipbook in the center of the window, if you choose

"No", the flipbook will be on the right side.

(3) Font Settings

EFont
HButtons
HTitle and Windows
HBookmark
HsSearch

Copyright 2010 by FlipBookMaker.com
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You can choose font color and font type for the buttons, title and windows,
bookmark and search result panel.
(4) Initial Show (Float and Spread templates only)
You can set initial show for bookmark and thumbnail, which will show in the
left panel.

(5) Show Corner Flip Effect

|| Show Corner Flip Effect  |True j

Set "True" for "Show Corner Flip Effect", then you will see the flip effect at

the corners.

Flip Book Maker for Shopping

Builder digital shopping catalog with page flipping effect.

m

NN
VR

Powered by flip-book-maker.com

(6) Background Config

| ElBackground Config
EHBackground Color
EHBackground

@ Background Color

| BlBackground Colar

Gradient Color A oxFFFFFF
Gradient Color B CloxFFa0FF
Gradient Angle a0

Define background color with gradient color or pure color (the same color for
"Gradient Color A" and "Gradient Color B"). Gradient Angle is the angle

Copyright 2010 by FlipBookMaker.com
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between two colors.

@Background Image

ElBackground
Duter Badkground File
| Background position  |Scale to fit ;I
Inner Background File  |D:‘program. ..
Backaround position Scale to fit

Choose background images for outer and inner backgrounds from your

computer:

Flio Book Maker for Shopping

Builder digital shopping catalog with page flipping effect.

And you can define the image position to fit the window scale:

Scale to fit

E—

Top Left

Top Center
Top Right
Middle Left
Middle Center
Middle Right

(7) Flash Window Color

| Flash Window Color | ASTRRToRTS)] ---

Choose color for flash window such as the book window, "Help" window,
"Print" window and so on.

(8) Page Background Color

|| Fage Background Color | Il

When loading pages, or if the page number of your PDF file is odd, the page (the
last page) will show with the "Page Background Color".

(9) Book Proportion
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| BlBook Proportions B
Fage Width 540
Page Height 720

You can define width and height for the flipbook.

(10) Book Margins

| ElBook Margins
Top Margin 10
Bottom Margin 10
Left Margin &l
Right Margin &l

Set parameter for the book margins such as top margin, bottom margin, left

margin and right margin.

(11) Page Shadow

| BlPage Shadow
Left page Shadow 90
Right page Shadow 55
Page Shadow Opadty 1

The value also takes the value of Book Proportions as reference, and the

value interval of
"Page Shadow Opacity" is "0~1", the larger value refers to the deeper shadow

color.
(12) Hide Book Frame Bar

i Hide Book Frame Bar Yes LI

If don’t want to show the book frame bar, choose “Yes” in this option.

(13) Right to Left

If the language of your file is read from right to left (such as Arabic), then

choose "Yes" in "Right to Left" option.

(14) If you want your book in hard cover, you can enable "Yes" for hard cover,

and you will see the hard cover effect.

Copyright 2010 by FlipBookMaker.com
-30-



Convert PDF to Digital Shopping Catalog Utility
User Document

ook, Twitter, Digg, ete
t pages

(15) Flipping Time

|| Flipping Time 0.6
Sets page flipping time in seconds according to your needs. (Recommended
value is 0.6)

(16) Page Number

| BlPage Mumber
Start Page Mumber (Roman) |0
Start Page Mumber (Arabic) [0

Define the start page number as you like. For example, the first 3 pages are
Table of Content

pages with Roman page numbers, and set Arabic page numbers from page 4,
then you will get

page number box like below:

| Bpegehumber [
| StartPage Mumber (Roman) |0 ‘

[ Start Page Mumber {Arabic) |3 [
\Front Cover Page: |

Pages:
\The Fourth and Fifth Pages: |
-
(17) Minime Style
| EMinime style

|Jse Minime Style Yes

Width 400

Height 300

If you don't like the tool bar present in the flipbook, you can choose the
Minime style to

hide the tool bar.

4. Flash Control Settings
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|E|Flash Control Settings
Security Settings
HLinks
Google Analytics ID

(1) Security Settings

| Security Settings J"
If you don't want others to view your flipbook, you can add password to

protect your

publication. CIickﬂ to enter into the security config interface.

I & Flash Security Config ' l&]

Mote:
Single Password option means that users need the password to view the flash book.

Exclude Front Pages option is to set a page number, all latter pages can'tbe
viewed without inputting password.

Security Type

@ No Security

| |
AN
= | Single Password:

Protect Page Range

(@) All Pages

Exdude Front Pages

= o=

Add password to retain access authorization. You can define to protect all

pages or set page

range.
(2) Links
| BlLinks
Maouse aver color M 0500030
Link alpha 0.2
Open Window Blank
Enable after zooming in Enable

If you have check "Import links" option in "Import PDF" interface, or add links in
"Edit Page" interface, then you can define settings here, choose "Mouse over
color", "Link alpha" (refers to the link area opacity, value interval: 0~1, "0"
stands for the area is totally transparent), and "Open Window->Blank/ Self". The
links also can be clicked after zooming by setting "Enable after Zooming

in->Enable".
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(3) Google Analytics ID

ot o — it [ —— |

| Google Analytics ID." | |

In the HTML output format, you can add statistics by using google analytics. You
can get more information about Google Analytics ID from the below site:

http://www.google.com/analytics/ .

» Bookmark Setting

Design Setting | Bookmark

GE ¢ ML X

¥ou can setup bookmarks here

|Title Fage |
= [ntroduction of Flip Boaok, kMaker... |1
Inbroduction 1

= Flip Book kaker for Shopping F... |2
[E] E ditable Shopping Cart 2

Optional output formats: w

If there is bookmark for your flipbook, you can import bookmark directly by

[

If you don't have an existing bookmark, you can add bookmark manually. Click

clicking ™" icon.

Lqe to add
titles, and click to add sub-titles, define page number for the title at the

bottom box and apply change.
Title: |Editable Shopping Cart

Page: |2

Input "title text; 3" directhy in the title ko quick
name booktitle as "title kext" and page as "3"

e

Click “"and ¥ tomove up/down the title. Click Hto export the bookmark.

» Application Options

Click "Option—>Application Option" to enter the below interface:
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BEEE

 High ualiy Duiput?

[] Using Gostscript ta create high qulity images

A% Meeds the free Gostscript to generate high quality images. Please download and install.

Choose to use Ghostscript to create high quality images or not.

» Output Option

After all settings are done, click "Apply Change" to save settings. Then you can

:":";-:55 Convert To Flipping Book
publish the flipbook. Click icon to convert the PDF to

flipbook and the output option interface will show up.

& Output Option ‘-'_ e
Output | ‘
Output type
L
. = 2 o
b @ = =l (71 2 - (55 " =
"’;a’ (@ =.hitml ™ *.z2ip \'ﬁ T exe ‘, = *.app
[7] Also Make Mobile Version  Make output page-fipping eBook works on iPad, Phone and Android mobile devices
@ How to make created eBooks available for others online?
Path I
Output Folder: E:\5 fiip programs manualManuals for Flip Book Ma Open
File Mame: index htmi l
Options I
HTML Title: 1 [y Advanced |
[ClBumn to co
E TR R 7 |
0:1:0,F; HL-DT-5T DVDRAM GT34N  ASO0
l
Make it automatically play the fiipbook in CD
o
== —— -

1. HTML
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Y @cami

This output type is for uploading created page-flipping ebook onto websites.
You can define HTML
Title and other properties by clicking "Advanced" button:

Options

HTML Title: demao |:-.¥ ﬁdvanced]

Set Keywords, Description or even Script in the below interface:
& Advanced Settings ﬁ

HTML Advanced Settings |
HTML Meta Settings
Title: demno

Keywords:  pdf, fipboak, page-fipping, ebook, online, website, flash, background, music

Description:  his page-fipping eﬁno(mu.\.-s you the stunning flash effect on POF pages, a

Add Scripts

You can put some tracking
code such as Google
Analytics here.,

Meed dosed <saript>tagl

[one ]

2.ZIP

Bz @ =zp

This output type is for compressing the created files into an integral ZIP
package which can be

sending out as attachment directly. You can also define HTML Advanced
Settings by clicking

"Advanced" icon. Your recipients just need to uncompress the ZIP file and
then they can view the

HTML flipbook instantly:

files

\E demuo.html

I::u:u:uk.swf

Uncompress

3. EXE

f"&;‘@l @ *.exe
This type is for outputting flipbook as a single executive file, easy storing and
easy viewing:

=27
demo.exe
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You can also define Icon and Opening Window Size in Advanced Settings:

i B Advanced Settings l!!i3E|‘

Exe Advanced Settings i

Exe Window Info .

Teon: d'_‘ﬁl v | | Dpefsut
ek | | ganea
4. APP

If you want to make executable application to run on Mac devices, you can
output as "*.app" format.

5. Mobile Version

: [¥] Also Make Mobile Version |

You can even output Mobile Version while choosing HTML or ZIP format at the
same time.

After creating mobile versions, you just need to output all files online
(including HTML, SWF, "files"

and "mobile" folders), then you can visit the flipbook page through your
mobile browser.

6. Burn to CD

[¥] Bucn to €D

CD Writer |D: 1:0,G: PLDS  DVD-ROM DH-16D55 VD15 =

Disc title: Page-Flipping eBook
[¥] Make it automatically play the fliphook in CD

After choosing output type, then check the option "Burn to CD", set "CD
Writer", define "Disc title".

> Batch Convert Mode

(+% Batch Convert
Click to batch convert multiple PDF files to flipbook
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& Batch Convert { =] -'?3-‘
|| #) Add PDF Documents I
! );r— Add Files o Add Eolder
MName Path
- [ Mg
)\ Settings
Output Settings | POF Setting
QOutput type L
:.:J @ =html =9 .2 ::TQ‘J, exe 4 .aop !
7] also Make Mobile Version  Make output page-flipping eBook works on iPad, iPhone and Android mobile devices
| Path i
Output Folder:  E:\5 flip programs manualManuals for Flip Book Maker\Flip Book Maker for PDF Manual Browse... H Open
File Mame: {PDF FileName} v html | File Hame I
|
Options
HTML Title: My FlipBook - {4y Advanced
Merge All PDF Files to One
<) Convert to Flash
|
k' Add Fi
. ke B nes .
1. Click== to add two or more PDF files;
. <L Add Eolder | .
2. Click ™% to import PDF files from the folder;

3. Choose output format and define output settings as the above mentioned.

» Command Line Mode

Flip Book Maker for PDF Pro also provide another conversion mode—Command
line mode, which can automate the conversion, and in this way, you can also
publish an interactive virtual flipbook with impressive page flip effect.

See below the command line mode:

Flip Book Maker for PDF Professional Command Line Usage:
PTCMD.exe [Options]
-f<PDF File> The source PDF file.

-o<output folder> Specify the folder for the output files.

-t[html|zip| exe] Output type. Default is html.

-n<OutputFileName>  Specify the name for the output file.
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-c<caption> Caption for HTML or EXE.

-s<Flash settings> Value format is:<Template name>#[<Theme name> |
<txt_settingfile path>].
<Template name> could be: Classic, Float, Spread.
<Theme name> are list in the "Select a template" window,
such as Blank,Blues,Nostalgia.
<txt_settingfile path> is the file that you export
with "Save the template settings" function

-r<page range>. The page range that you want to import from PDF File.
Range value string like:2-15,33,35-36,0r All.(Default: All)

-g<import quality> Count be 5,4,3,2,1.5 specify the higher quality larger file
size;1 specifies lower quality smaller file size.(default:4)

-R<GS|SWF|LIB> Render engine options. (Default: GS, Ghostscript render
engine)

-b<Y|N> Import bookmark yes or no. (Default: Y)

-I<Y|N> Import links yes or no. (Default: Y).

-S<Y|N> Enable searchable or not.(Default: Y, enable searchable)

-k<html key words> Set the keywords for html output file.
-d<html description>  Set the descriptions for html output file.
-j<html javascript> Set the javascript for html output file.
-i<icon file path> Specify the icon path for exe output.
-w<window size> Specify the size of exe window.

Value could be: M,F, or some string like:800,600.
(width is 800,height is 600).

Examples 1:
PTCMD -f"C:\input.pdf" -0"C:\outputfolder" -n"index" -thtml -c"Title"
-s"Float#c:\my_ebooksetting.txt" -r"1-8,9-14,42" -q4 -R"SWF" -bN
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Examples 2:
PTCMD -f"C:\input.pdf" -0"C:\outputfolder" -n"ExeFileName" -texe -i"C:\app.ico"
-c"Title" -s"Float#Blues" -r"All" -g5 -R"GS"

Examples 3:
PTCMD  -f"C:\input.pdf"  -o"C:\outputfolder" -n"index" -tzip -c"Title"
-s"Float#Blank" -r"All" -5 -R"GS" -k"html key words"\

Return Code:

Success

Input file not found

Parameters are invalid

Failed to load PDF

Failed to import bookmarks

Failed to import links

Failed to import searchable information
Failed to save the output file.

N R WD R
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